
WinSight Help Contents
Click a folder icon to expand or collapse a list of topics for an item. To expand or collapse all folders, 
click the icon in the title of this topic. Read Basics if you are new to WinSight or new to this version of 
WinSight. If you need information on using the Help system, return to the Help menu and choose 
Using Help.

Basics: Overview of features; concepts you'll 
need to know for working with WinSight.

Tasks: Information on using WinSight.

Menu Commands: A list of WinSight menus.

Shortcut: Use the Search button at the top of this Help window to search for a topic by name. 



WinSight Help Contents
Click a folder icon to expand or collapse a list of topics for an item. To expand or collapse all folders, 
click the icon in the title of this topic. Read Basics if you are new to WinSight or new to this version of 
WinSight. If you need information on using the Help system, return to the Help menu and choose 
Using Help.

Basics: Overview of features; concepts 
you'll need to know for working with 
WinSight.

Getting Started
Messages WinSight Tracks 
WinSight Views

Tasks: Information on using WinSight.

Tracing Messages 
Using the Find Window Mode
Using the Keyboard with WinSight
Using the Messages Menu to Trace 

Messages 
Using the Mouse with WinSight
Using the Spy Menu to Display 

Window Details 
Using the Start! and Stop! Menu 
Using the Tree Menu to Display the 

Window Tree View 
Using the View Menu to Display 

WinSight Views 

Menu Commands: A list of WinSight menus.

Control Menu 
Spy Menu 
View Menu 
Tree Menu 
Messages Menu 
Stop! and Start! Menu 
Help Menu 

Shortcut: Use the Search button at the top of this Help window to search for a topic by name. 



WinSight Help Contents
Click a folder icon to expand or collapse a list of topics for an item. To expand or collapse all folders, 
click the icon in the title of this topic. Read Basics if you are new to WinSight or new to this version of 
WinSight. If you need information on using the Help system, return to the Help menu and choose 
Using Help.

Basics: Overview of features; concepts you'll 
need to know for working with WinSight.

Getting Started
Messages WinSight Tracks 
WinSight Views

Tasks: Information on using WinSight.

Menu Commands: A list of WinSight menus.

Shortcut: Use the Search button at the top of this Help window to search for a topic by name. 



WinSight Help Contents
Click a folder icon to expand or collapse a list of topics for an item. To expand or collapse all folders, 
click the icon in the title of this topic. Read Basics if you are new to WinSight or new to this version of 
WinSight. If you need information on using the Help system, return to the Help menu and choose 
Using Help.

Basics: Overview of features; concepts you'll 
need to know for working with WinSight.

Tasks: Information on using WinSight.

Tracing Messages 

Using the Find Window Mode

Using the Keyboard with WinSight

Using the Messages Menu to Trace 
Messages 

Using the Mouse with WinSight

Using the Spy Menu to Display 
Window Details 

Using the Start! and Stop! Menu 

Using the Tree Menu to Display the 
Window Tree View 

Using the View Menu to Display 
WinSight Views 

Menu Commands: A list of WinSight menus.

Shortcut: Use the Search button at the top of this Help window to search for a topic by name. 



WinSight Help Contents
Click a folder icon to expand or collapse a list of topics for an item. To expand or collapse all folders, 
click the icon in the title of this topic. Read Basics if you are new to WinSight or new to this version of 
WinSight. If you need information on using the Help system, return to the Help menu and choose 
Using Help.

Basics: Overview of features; concepts you'll 
need to know for working with WinSight.

Tasks: Information on using WinSight.

Menu Commands: A list of WinSight menus.

Control Menu 

Spy Menu 

View Menu 

Tree Menu 

Messages Menu 

Stop! and Start! Menu 

Help Menu 

Shortcut: Use the Search button at the top of this Help window to search for a topic by name. 



 Basics
WinSight gives you debugging information about window classes, windows, and messages. Using 
WinSight, you can study how any application creates classes and windows and monitor how windows 
send and receive messages.
WinSight uses three views to study applications:

Window Tree view
Class List view
Message Trace view

WinSight is a passive observer: it intercepts and displays information about messages but does not 
prevent messages from getting to applications.
To watch windows sending and receiving messages, you can use WinSight to do the following:

Find the window(s) you want to watch
Trace the messages that get sent

What you need to know to begin using WinSight
Choose one of these topics for more information:
Getting Started
Messages WinSight Tracks 
WinSight Views



 Tasks
Choose one of these topics for information about using WinSight:
Tracing Messages 
Using the Find Window Mode
Using the Keyboard with WinSight
Using the Messages Menu to Trace Messages 
Using the Mouse with WinSight
Using the Spy Menu to Display Window Details 
Using the Start! and Stop! Menu 
Using the Tree Menu to Display the Window Tree View 
Using the View Menu to Display WinSight Views 



 Getting Started
See Also
To start WinSight, double-click the WinSight icon.
The first time you start WinSight, it displays the Window Tree view.
When you exit, WinSight saves your configuration. If you open all three views and exit WinSight, the 
next time you start it, all three views will be displayed.



See Also
WinSight Views





 Using the Mouse with WinSight
Here is a list of actions with mouse and menu equivalents.

Action With the mouse With menus
Select an item Click
Select multiple items Ctrl+click
Toggle highlighted item Shift+click
Show details of item Double-click Spy|Open Detail
Expand one level Click on <+> Tree|Expand One Level
Expand branch Right-click on <+> Tree|Expand Branch
Collapse branch Click on <-> Tree|CollapseBranch
You can also use the mouse to resize the WinSight window or the panes.



 Using the Keyboard with WinSight
Here is a list of actions with keyboard and menu equivalents.

Action With the keyboard With menus
Select an item Up or Down arrow
Select multiple items Ctrl+Shift Up or Down 

arrow
Move selection bar Ctrl+Up or Down arrow
Toggle highlighted item Spacebar
Expand one level + Tree|Expand One Level
Expand branch * Tree|Expand Branch
Expand tree completely Ctrl+* Tree|Expand All
Collapse branch - Tree|Collapse Branch
The right and left arrows scroll horizontally.
Use Tab or F6 to move the focus between panes. Use Shift+Tab or Shift+F6 to switch the focus in the 
opposite direction.





Using WinSight
See Also
WinSight gives you debugging information about window classes, windows, and messages. You can 
study how any application creates classes and windows, and monitor how windows send and receive 
messages.
WinSight uses three views to study applications:

Window Tree view
Class List view
Message Trace view

WinSight is a passive observer: it intercepts and displays information about messages but does not 
prevent messages from getting to applications.
To watch Windows sending and receiving messages, you can use WinSight to

Find the window(s) you want to watch
Trace the messages that get sent.



See Also
WinSight Views



 Find Window Mode
See Also
Find Window mode allows you to monitor how specific windows send and receive messages. To enter 
Find Window mode choose Spy|Find Window.
Note: All other applications are suspended while you are in Find Window mode.

Selecting Windows
In Find Window mode, you can select windows in one of two ways:

Move the mouse into the boundaries of a window object. A thick border appears around 
that window object, and the corresponding window name is highlighted in the Window Tree view. 

Use the cursor keys to select windows from the Window Tree view. When you hightlight a
window name, WinSight puts a thick border around the corresponding window object.

To leave Find Window mode, click the mouse button, or press Escape. This removes the border from 
the screen but leaves the current window selected in the Window Tree view. 
If you press Enter or double-click the highlighted window in the Window Tree view, you will see the 
Detail window.



See Also
Tracing Messages



 Tracing Messages
See Also
When you monitor how windows or classes send and receive messages, you are tracing the patterns 
of these messages.
By default WinSight traces all messages and displays them in the Message Trace view.
You can trace messages in one of three ways:

Choose Messages|Selected Classes or Messages|Selected Windows, then shift-click to 
select the classes (in the Class List view) or windows (in the Window Tree view) you want to trace.

Choose Messages|All Windows to select all the messages sent to windows.

Choose Messages|Options, then select any or all of the ten groups of messages.
Choose Stop! or Messages|Trace Off to control when WinSight stops tracing messages. The Message 
Trace view remains visible. 
To resume tracing, choose one of the following menu commands:

Start!

Messages|Selected Classes

Messages|Selected Windows

Messages|All Windows



See Also
Finding Windows
Messages Menu
Messages Winsight Traces





 WinSight Menu Commands
Here is a list of the menus and menu commands in WinSight. The menus are listed in the order they 
appear.
Control Menu 

Restore 
Move 
Size 
Minimize 
Maximize 
Close 
Switch to 

Spy Menu 
Open Detail 
Find Window 
Exit 

View Menu 
Class List 
Window Tree 
Message Trace 
Split Horizontal 
Split Vertical 

Tree Menu 
Expand One Level 
Expand Branch 
Expand All 
Collapse Branch 

Messages Menu 
Trace Off 
Selected Classes 
Selected Windows 
All Windows 
Clear 
Options... 

Stop! and Start! 
Help Menu 

Index 
Finding Windows 
Tracing Messages 
Menu Commands 
Keyboard 
Mouse 
Using Help 
About WinSight 







 Spy Menu
Use the Spy menu to display more details for a window, locate the window for which you want to trace 
messages, or exit WinSight.
The Spy menu commands are:
Open Detail
Find Window
Exit



Spy | Open Detail
Choose Spy|Open Detail to display more detail about the selected class or window.
Use this command to open the Detail window.    The information in the window depends on the current 
active view, indicated by the dotted rectangle. 



Spy | Find Window
Choose Spy|Find Window to locate the window for which you want to trace messages. Use this 
command to enter Find Window mode.



Spy | Exit
Choose Spy|Exit to exit WinSight.





 View Menu
Choose the View menu to select a view and how WinSight displays it, either horizontally or vertically.
The View commands are:
Class List
Window Tree
Message Trace
Split Horizontal
Split Vertical



 WinSight Views
See Also
WinSight can display three views within its main window:

Class List

Window Tree

Message Trace
The Window Tree view is the initial default view, but you can use the View menu to open or close any 
of these views. 
When you exit WinSight, WinSight saves your current desktop configuration. 
WinSight automatically tiles the views within the main window, however, you can resize them. 



See Also
Tree Menu



View | Class List
Choose the View|Class List command to display the Class List view.
If the Class List view is displayed, choosing this command hides the view.
Note: The term "class" refers to the class name with which the window class was registered with 

Windows via the RegisterClass API function. It does not refer to C++ classes.



 Class List View
See Also
The Class List view displays all the currently registered window classes. 
The format for the classes in the Class List view is:
Class (Module) Function Styles
You can see more information about a window class in the Detail window by doing one of the following:

Double-clicking the window class in the Class List view.

Selecting the window class and press Enter.

Selecting the window class and choose Spy|Open Detail. 



See Also
Tree Menu
View|Class List
WinSight Views



View | Window Tree
Choose View|Window Tree to display the Window Tree view.
If the Window Tree view is displayed, choosing this command hides the view.



 Window Tree View
See Also
The Window Tree view displays the hierarchy of windows on the desktop. 
Use this display to do the following:

Determine what windows are actually present.

See the status of windows, including hidden windows.

See which windows are receiving messages.

Select the windows you want to trace messages for.
The format for the classes in the Window Tree view is:
Tree Handle {Class} Module Position "Title"
You can see more information about a window in the Detail window by doing one of the following:

Double-click the window item in the view.

Select the window item and press Enter.

Select the window item and choose Spy|Open Detail.



See Also
Finding Windows
Tree Menu
View|Window Tree
WinSight Views



 Detail Window
See Also
The Detail window displays the class name, executable module, and other information about the 
selected window or class.



See Also
Class List View
Window Tree View



View | Message Trace
Choose the View|Message Trace command to display the Message Trace view.
If the Message Trace view is displayed, choosing this command hides the view.



 Message Trace View
See Also
The Message Trace view displays information about messages received by selected windows or 
windows classes.
SendMessage messages are shown twice, once when they are sent and again when they return. 
Dispatched messages are shown only once, since their return value is meaningless. The message 
display is indented to show how messages are nested within other messages.
The format for the messages in the Message Trace window is:
Handle "Title"-or-{Class} Message Status ...
Win32 Messages
Winsight checks if the task whose messages are being traced is a Win32 task. If so, it displays 
[Win32] immediately after the window handle on traced messages. These messages, however, are 
displayed in Win16 message format.



See Also
View|Message Trace
WinSight Views



View | Split Horizontal
Choose View|Split Horizontal to stack the views on top of one another.



View | Split Vertical
Choose View|Split Vertical to display the views side by side.



Class
The name of the window class. 
Some predefined Windows classes have numeric names and are shown with the number and a name.



Module
The name of the executable module (.EXE or .DLL) that registered the class or created the window.



Function 
The address of the class window function.



Styles 
A list of the CS_ styles for the class. The names are the same as the CS_ definitions in WinTypes, 
except that the CS_ is removed and the name is in mixed case.



Tree
The lines and diamonds on the left of the view show the window tree structure. Each window is 
connected to its parent, siblings, and children. 



Handle
The window handle returned by CreateWindow.



Position
The window's position. 
If the window is hidden, the text "(hidden)" is displayed. 
If the window is visible, the window coodinates are given as (xBegin,yBegin)-(xEnd,yEnd). Top-level 
windows use their own screen coordinates. Child windows use coordinates within the parent window 
client area. 



Title
The window title or text, returned by GetWindowText or a WM_GETTEXT message. If the title is the 
null string, the quotation marks are omitted.
If the title is a null string in the Message Trace window, the class name is displayed in curly braces.



Message
The message name defined in WINDOWS.H. 
Known undocumented Windows messages are shown in lower case. 
Unknown message numbers (user-defined) are shown in one of the following formats: 

WM_USER+0xXXXX if they are greater than or equal to WM_USER 

WM_0xXXXX if they are less than WM_USER.
Registered message numbers (from RegisterWindowsMessage) are shown with their registered name 
in single quotation marks.



Status
One or more of the following items may be reported:
Dispatched The message was received via DispatchMessage
Sent [from XXXX] The message was received via SendMessage. If it was sent from another window, 

"from XXXX" gives that window's handle. If it was sent from the same window 
receiving it, this is shown with "from self." If it was sent from Windows itself, the 
"from" phrase is omitted. 

Returns The message was received via SendMessage and is now returning.



...
Additional information specific to each message.
If a "returning message", the return value, either in numeric form, or more specific information for 
messages such as WM_GETTEXT. 
If a "sent and dispatched message", the message parameters. WinSight interprets the parameters to 
give a readable display. If a message has associated data structures, those structures are included in 
the display.





 Tree Menu
Choose the Tree menu to display, expand, or collapse window entries in the Window Tree view.
The diamonds on the left of the Class List and Window Tree windows invert color momentarily when 
the window receives a message. They also show if the window class has any children:

The window has no children. 
The window has children, but they are hidden. To expand and see the children, click on the 

diamond, or select the window and press 
. To expand to show all levels of child windows, select a window and right-click.

The window has children, and they are visible. To hide the children again, click the diamond, or 
select the parent window and press 

.
The Tree menu commands are:
Expand One Level
Expand Branch
Expand All
Collapse Branch



Tree | Expand One Level (+)
See Also
Choose Tree|Expand One Level to expand an entry one level in the Window Tree view.

A plus sign in the diamond ( ) next to an entry indicates that the window has children, but they are 
hidden.



See Also
Tree|Collapse Branch
Tree|Expand All
Tree|Expand Branch



Tree | Expand Branch (*)
See Also
Choose Tree|Expand Branch to expand an entire branch in the Window Tree view.

A plus sign in the diamond ( ) next to an entry indicates that the window has children, but they are 
hidden.



See Also
Tree|Collapse Branch
Tree|Expand All
Tree|Expand One Level



Tree | Expand All (Ctrl+*)
See Also
Choose Tree|Expand All to expand all branches that are collapsed in the Window Tree view.

A plus sign in the diamond ( ) next to an entry indicates that the window has children, but they are 
hidden.



See Also
Tree|Collapse Branch
Tree|Expand Branch
Tree|Expand One Level



Tree | Collapse Branch (-)
See Also
Choose Tree|Collapse Branch to collapse an entire branch in the Window Tree view.

A minus sign in the diamond ( ) next to an entry indicates that the window's children are currently 
hidden.



See Also
Tree|Expand All
Tree|Expand Branch
Tree|Expand One Level





 Messages Menu
See Also
Choose the Messages menu to select the types of messages you want to trace for the selected 
window(s).
You can configure WinSight to trace messages by:

Window

Window class

Message type

A combination of these
The Messages menu commands are:
Trace Off
Selected Classes
Selected Windows
All Windows
Clear
Options...



See Also
Messages WinSight Traces



Messages | Selected Classes
Choose Messages|Selected Classes to trace messages going to a particular class. 
This command is active only if you select a class in the Class List view.
Changing the selection in the Class List view will immediately change which windows have messages 
traced.
Choose Messages|Selected Classes to open the Message Trace view when it is hidden.



Messages | Selected Windows
Choose Messages|Selected Windows to trace messages going to a particular window.
This command is active only if you select a window in the Window Tree view.
Changing the selection in the Window Tree view will immediately change which windows have 
messages traced.
Choose Messages|Selected Windows to open the Message Trace view when it is hidden.



Messages | All Windows
Choose Messages|All Windows to trace all messages, regardless of what is selected in the Window 
Tree view or the Class List view.
Choose Windows|All Windows to open the Message Trace view when it is hidden.



Messages | Trace Off
Choose Messages|Trace Off to turn off message tracing. The Message Trace view remains visible.
Tracing resumes when you choose one of the following menu commands:

Messages|Selected Classes

Messages|Selected Windows

Messages|All Windows
You can also use Stop! to turn off message tracing.



Messages | Clear
Choose Messages|Clear to clear all messages in the Message Trace view.



Messages | Options...
Choose Messages|Options... to open the Message Trace Options dialog box.
Use the Messages Trace Options dialog box to choose the types of messages you want to trace. 

Messages to Trace check boxes
Use the Messages to Trace check boxes and the Individual Messages List Box to choose which 
messages to trace.

Interpret and Hex Values check boxes
Use the Interpret and Hex Values check boxes to determine the message display format.

Log File check box
Use the Log File check box to log traced messages.



Messages to Trace Check Boxes
See Also
Use the Messages to Trace check boxes on the Message Trace Options dialog box to choose the 
types of messages to trace.
You can configure WinSight to trace any of the following:

All messages

Subgroups of messages

Individual messages

A combination of groups and individual messages

All Messages
The All Messages checkbox allows you to select or deselect all ten subgroups of messages.
When All Messages is selected, all messages in the Individual Messages Display Box are highlighted. 
The All Messages checkbox is dimmed when the list box is used to either select or deselect an 
individual message.

Message Subgroups
To select specific types of messages, uncheck All Messages and check individual message groups. 
Checking the All Messages checkbox also turns on these checkboxes. Unchecking the All Messages 
checkbox turns off previously selected subgroup checkboxes.
When a subgroup is selected, the messages in that subgroup are highlighted in the Individual 
Messages Display Box. The subgroup checkbox is dimmed when the list box is used to either select or
deselect an individual message in that group. 

"Other" checkbox
The "Other" checkbox allows tracing of all messages that WinSight does not know about, such as 
unknown WM_USER+xxxx and registered messages. This checkbox must be on for these messages 
to be traced. Checking the All Messages checkbox also turns on this checkbox.

Individual Messages List Box
The Individual Messages List Box displays all of the messages that WinSight knows about. It is here 
that individual messages are selected or deselected. The All Messages checkbox and corresponding 
subgroup checkboxes are dimmed to indicate when individual messages are selected or deselected.



See Also
Messages|Options



Mouse Messages
See Also
Check Mouse on the Message Trace Options dialog box to trace mouse messages. 
The mouse messages that WinSight traces are:
WM_HSCROLL
WM_LBUTTONDBLCLK
WM_LBUTTONDOWN
WM_LBUTTONUP
WM_MBUTTONDBLCLK
WM_MBUTTONDOWN
WM_MBUTTONUP
WM_MOUSEACTIVATE
WM_MOUSEMOVE
WM_RBUTTONDBLCLK
WM_RBUTTONDOWN
WM_RBUTTONUP
WM_SETCURSOR
WM_VSCROLL



See Also
Messages|Options
Messages WinSight Traces



Window Messages
See Also
Check Window on the Message Trace Options dialog box to trace window messages.
The window messages that WinSight traces are (those messages in lowercase are undocumented 
Windows messages):
WM_ACTIVATE
WM_ACTIVATEAPP
WM_CANCELMODE
WM_CHILDACTIVATE
WM_CLOSE
WM_CREATE
WM_CTLCOLOR
WM_DESTROY
WM_ENABLE
WM_ENDSESSION
WM_ERASEBKGND
WM_GETDLGCODE
WM_GETMINMAXINFO
WM_GETTEXT
WM_GETTEXTLENGTH
WM_ICONERASEBKGND
WM_KILLFOCUS
WM_MOVE
WM_PAINT
wm_painticon
WM_QUERYDRAGICON
WM_QUERYENDSESSION
WM_QUERYNEWPALETTE
WM_QUERYOPEN
WM_QUIT
WM_SETFOCUS
WM_SETFONT
WM_SETREDRAW
WM_SETTEXT
WM_SHOWWINDOW
WM_SIZE
WM_WINDOWPOSCHANGED
WM_WINDOWPOSCHANGING



See Also
Messages|Options
Messages WinSight Traces



Input Messages
See Also
Check Input on the Message Trace Options dialog box to trace input messages. 
The input messages that WinSight traces are (those messages in lowercase are undocumented 
Windows messages):
WM_CHAR
WM_CHARTOITEM
WM_COMMAND
WM_DEADCHAR
WM_KEYDOWN
WM_KEYUP
WM_KEYLAST
WM_MENUSELECT
WM_MENUCHAR
WM_PARENTNOTIFY
WM_SYSCHAR
WM_SYSKEYDOWN
WM_SYSKEYUP
WM_SYSDEADCHAR
WM_TIMER
WM_VKEYTOITEM
sm_yomichar

Notification Control Messages
BN_CLICKED                                
BN_DOUBLECLICKED                    
BN_CLOSEUP                                
BN_DBLCLK                                  
BN_DROPDOWN                              
BN_EDITCHANGE 
CBN_CLOSEUP
CBN_DBLCLK 
CBN_DROPDOWN 
CBN_EDITCHANGE 
CBN_EDITUPDATE                        
CBN_ERRSPACE                                            
CBN_KILLFOCUS                          
CBN_SELCHANGE                          
CBN_SELENDCANCEL                      
CBN_SELENDOK                              
CBN_SETFOCUS                                            
EN_CHANGE                                  
EN_ERRSPACE                            
EN_HSCROLL                                
EN_KILLFOCUS                                            



EN_MAXTEXT                                
EN_SETFOCUS                              
EN_UPDATE                                  
EN_VSCROLL                                
LBN_DBLCLK                                
LBN_ERRSPACE                                            
LBN_KILLFOCUS                          
LBN_SELCANCEL                            
LBN_SELCHANGE                          
LBN_SETFOCUS                                          



See Also
Messages|Options
Messages WinSight Traces



System Messages
See Also
Check System on the Message Trace Options dialog box to trace system messages.
The system messages that WinSight traces are:
WM_COMPACTING
WM_DEVMODECHANGE
WM_ENTERIDLE
WM_FONTCHANGE
WM_NULL
WM_PALETTECHANGED
WM_PALETTEISCHANGING
WM_POWER
WM_QUEUESYNC
WM_SPOOLERSTATUS
WM_SYSCOLORCHANGE
WM_SYSCOMMAND
WM_TIMECHANGE
WM_WININICHANGE



See Also
Messages|Options
Messages WinSight Traces



Pen Messages
See Also
Check Pen on the Message Trace Options dialog box to trace pen messages.
The pen messages that WinSight traces are:
WM_RCRESULT
WM_HOOKRCRESULT
WM_GLOBALRCCHANGE
WM_SKB
WM_HEDITCTL



See Also
Messages|Options
Messages WinSight Traces



Initialization Messages
See Also
Check Initialization on the Message Trace Options dialog box to trace initialization messages.
The initialization messages that WinSight traces are:
WM_INITDIALOG
WM_INITMENU
WM_INITMENUPOPUP



See Also
Messages|Options
Messages WinSight Traces



Clipboard Messages
See Also
Check Clipboard on the Message Trace Options dialog box to trace initialization messages. 
The clipboard messages that WinSight traces are:
WM_ASKCBFORMATNAME
WM_CHANGECBCHAIN
WM_CLEAR
WM_COPY
WM_CUT
WM_DESTROYCLIPBOARD
WM_DRAWCLIPBOARD
WM_HSCROLLCLIPBOARD
WM_PAINTCLIPBOARD
WM_PASTE
WM_RENDERALLFORMATS
WM_RENDERFORMAT
WM_SIZECLIPBOARD
WM_UNDO
WM_VSCROLLCLIPBOARD



See Also
Messages|Options
Messages WinSight Traces



DDE Messages
See Also
Check DDE on the Message Trace Options dialog box to trace dynamic data exchange messages.
The DDE messages that WinSight traces are:
WM_DDE_ACK
WM_DDE_ADVISE
WM_DDE_DATA
WM_DDE_EXECUTE
WM_DDE_INITIATE
WM_DDE_POKE
WM_DDE_REQUEST
WM_DDE_TERMINATE
WM_DDE_UNADVISE



See Also
Messages|Options
Messages WinSight Traces



Non Client Messages
See Also
Check Non Client on the Message Trace Options dialog box to trace non client messages.
The non client messages that WinSight traces are:
WM_NCACTIVE
WM_NCCALCSIZE
WM_NCCREATE
WM_NCDESTROY
WM_NCHITTEST
WM_NCLBUTTONDBLCLK
WM_NCLBUTTONDOWN
WM_NCLBUTTONUP
WM_NCMBUTTONDBLCLK
WM_NCMBUTTONDOWN
WM_NCMBUTTONUP
WM_NCMOUSEMOVE
WM_NCPAINT
WM_NCRBUTTONDBLCLK
WM_NCRBUTTONDOWN
WM_NCRBUTTONUP



See Also
Messages|Options
Messages WinSight Traces



Controls Messages
See Also
Check Controls on the Message Trace Options dialog box to trace control messages.
The control messages that WinSight traces are:
BM_GETCHECK                              
BM_GETSTATE                              
BM_SETCHECK                              
BM_SETSTATE                              
BM_SETSTYLE                              
CB_ADDSTRING                            
CB_DELETESTRING                      
CB_DIR                                        
CB_FINDSTRING                          
CB_FINDSTRINGEXACT              
CB_GETCOUNT                              
CB_GETCURSEL                            
CB_GETDROPPEDCONTROLRECT    
CB_GETDROPPEDSTATE                
CB_GETEDITSEL                          
CB_GETEXTENDEDUI                    
CB_GETITEMDATA                        
CB_GETITEMHEIGHT                    
CB_GETLBTEXT                            
CB_GETLBTEXTLEN                      
CB_INSERTSTRING                      
CB_LIMITTEXT                            
CB_RESETCONTENT                      
CB_SELECTSTRING                      
CB_SETCURSEL                            
CB_SETEDITSEL                          
CB_SETEXTENDEDUI                    
CB_SETITEMDATA                        
CB_SETITEMHEIGHT                    
CB_SHOWDROPDOWN                      
DM_GETDEFID                            
DM_SETDEFID                              
EM_CANUNDO                                
EM_EMPTYUNDOBUFFER                
EM_FMTLINES                              
EM_GETFIRSTVISIBLELINE        
EM_GETHANDLE                            
EM_GETLINE                                
EM_GETLINECOUNT                      
EM_GETMODIFY                            



EM_GETPASSWORDCHAR                
EM_GETRECT                                
EM_GETSEL                                  
EM_GETWORDBREAKPROC              
EM_LIMITTEXT                            
EM_LINEFROMCHAR                      
EM_LINEINDEX                            
EM_LINELENGTH                          
EM_LINESCROLL                          
EM_REPLACESEL                          
EM_SETHANDLE                            
EM_SETMODIFY                          
EM_SETPASSWORDCHAR                
EM_SETREADONLY                        
EM_SETRECT                                
EM_SETSEL                                  
EM_SETRECTNP                            
EM_SETTABSTOPS                        
EM_SETWORDBREAK                      
EM_SETWORDBREAKPROC              
EM_UNDO                                      
LB_ADDSTRING                            
LB_DELETESTRING                      
LB_DIR                                        
LB_FINDSTRING                          
LB_FINDSTRINGEXACT                
LB_GETCARETINDEX                    
LB_GETCOUNT                              
LB_GETCURSEL                            
LB_GETHORIZONTALEXTENT        
LB_GETITEMDATA                        
LB_GETITEMHEIGHT                    
LB_GETITEMRECT                      
LB_GETSEL                                  
LB_GETSELCOUNT                        
LB_GETSELITEMS                        
LB_GETTEXT                                
LB_GETTEXTLEN                          
LB_GETTOPINDEX                        
LB_INSERTSTRING                      
LB_RESETCONTENT                      
LB_SELECTSTRING                      
LB_SELITEMRANGE                      
LB_SETCARETINDEX                    



LB_SETCOLUMNWIDTH                  
LB_SETCURSEL                            
LB_SETHORIZONTALEXTENT        
LB_SETITEMDATA                        
LB_SETITEMHEIGHT                    
LB_SETSEL                                  
LB_SETTABSTOPS                        
LB_SETTOPINDEX                        
STM_GETICON                              
STM_SETICON



See Also
Messages|Options
Messages WinSight Traces



Multimedia Messages
See Also
Check Multimedia on the Message Trace Options dialog box to trace multimedia messages.
The multimedia messages that WinSight traces are:
MM_JOY1MOVE
MM_JOY1BUTTONDOWN
MM_JOY1BUTTONUP
MM_JOY1ZMOVE
MM_JOY2MOVE
MM_JOY2BUTTONDOWN
MM_JOY2BUTTONUP
MM_JOY2ZMOVE
MM_MCINOTIFY
MM_MIM_CLOSE
MM_MIM_DATA
MM_MIM_ERROR
MM_MIM_LONGDATA
MM_MIM_LONGERROR
MM_MIM_OPEN
MM_MOM_CLOSE
MM_MOM_DONE
MM_MOM_OPEN
MM_WIM_CLOSE
MM_WIM_DATA
MM_WIM_OPEN
MM_WOM_CLOSE
MM_WOM_DONE
MM_WOM_OPEN



See Also
Messages|Options
Messages WinSight Traces



Other Messages
See Also
Check Other on the Message Trace Options dialog box to trace other types of messages. 
The other messages that WinSight traces are (those messages in lowercase are undocumented 
Windows messages):
wm_alttabactive                      
wm_begindrag                            
WM_COMMNOTIFY                          
WM_COMPAREITEM                        
wm_convertrequest                  
wm_convertresult                    
WM_DELETEITEM                        
wm_dragloop                              
wm_dragmove                              
wm_dragselect                          
WM_DRAWITEM                              
WM_DROPFILES                            
wm_dropobject                          
wm_entermenuloop                    
wm_entersizemove                    
wm_exitmenuloop                      
wm_exitsizemove                      
wm_filesyschange                    
WM_GETFONT                                
wm_gethotkey
wm_isactiveicon                      
wm_lbtrackpoint                      
WM_MDIACTIVATE                        
WM_MDICASCADE                          
WM_MDICREATE                            
WM_MDIDESTROY                          
WM_MDIGETACTIVE                      
WM_MDIICONARRANGE                  
WM_MDIMAXIMIZE                      
WM_MDINEXT                                
WM_MDIRESTORE                          
WM_MDISETMENU                          
WM_MDITILE                                
WM_MEASUREITEM                        
WM_NEXTDLGCTL                          
wm_nextmenu                              
wm_querydropobject                
wm_queryparkicon                    
wm_setvisible                          



wm_sethotkey
wm_sizewait                              
wm_syncpaint                            
wm_synctask                              
WM_SYSTEMERROR                        
wm_systimer                              
wm_testing                              



See Also
Messages|Options
Messages WinSight Traces



Interpret and Hex Values Check Boxes
See Also
The Interpret and Hex Values check boxes determine the format of the Message Trace view display.
Turn the Interpret Values check box on to interpret message parameters and return values in a 
readable format.
Turn the Hex Values check box on to display message parameters as Hex Values of wParam and 
lParam, and also return Values as Hex.



See Also
Messages|Options



Log File Check Box
See Also
Check Log File to log trace messages to a file. 
Enter a file name in the input box below the check box. If the file already exists, messages are 
appended to the end of the file.
To stop logging messages to the file, turn off the Log File check box.



See Also
Messages|Options



 Messages WinSight Tracks
See Also
The messages that WinSight tracks are listed under the following group headings. 
Click a group to see the corresponding list of messages tracked by WinSight.
Mouse 
Window 
Input 
System 
Pen
Initialization 
Clipboard 
DDE 
Non Client 
Control 
MultiMedia
Other 



See Also
Messages|Options





 Stop! and Start! Menu
See Also
Use the Stop! and Start! menu to turn off or on real-time updating in WinSight. 
All views are kept current as classes are registered, windows are created and destroyed, and 
messages are received. 
This command is a toggle. When you choose Stop! to suspend activity, the command changes to 
Start!. When you choose Start! to resume activity, the command changes to Stop!.
Using Stop! allows you to study a particular situation. It also removes the overhead of having WinSight
update itself constantly.
You can also use Messages|Trace Off to stop message tracing.



See Also
Tracing Messages





 Help Menu
The Help menu provides access to online Help, which comes up in a special Help window. One-line 
menu hints also appear on the status line at the bottom of the screen whenever you select a menu 
command.
The Help menu commands are:
Index
Finding Windows
Tracing Messages
Menu Commands
Keyboard
Mouse
Using Help
About WinSight



Help | Index (F1)
The WinSight online Help has a contents screen that summarizes the organization and contents of the 
Help system. 
To access the Help system from the index, choose one of the highlighted words or pictures on the 
contents: click it or Tab to it and then press Enter.
For more information on how to use a Help system under Windows, choose the Help|Using Help menu
command.



Help | Finding Windows
The Help|Finding Windows command displays help on locating windows.



Help | Tracing Messages
The Help|Tracing Messages command displays help on tracing messages.



Help | Menu Commands
Help|Menu Commands displays help on WinSight menus.



Help | Keyboard
The Help|Keyboard command displays help on the keyboard.



Help | Mouse
The Help|Mouse command displays help on the mouse.



Help | Using Help
The Help|Using Help command displays information on how to use the WinSight Help system (or any 
other Help system under Windows).



Help | About
The About command displays a dialog box that shows copyright and version information. 
Click OK or Enter to close the About dialog box. 





 Control Menu
The WinSight Control-menu box is on the far left of the title bar. Click it once or press Alt+Spacebar to 
display the menu.
The commands that appear on this menu affect the WinSight desktop.
The WinSight Control menu commands are:
Restore
Move
Size
Minimize
Maximize
Close
Switch To



Control | Restore
The Restore command returns the WinSight desktop window to its previous size.
This command is available only if the WinSight desktop window is maximized or minimized. 



Control | Move
The Move command moves the WinSight desktop window with your keyboard.
Use the arrow cursor keys to move it, and press Enter when you finish.
You cannot use this command if the WinSight desktop is maximized.
You can also move the window by dragging its title bar to the desired position.



Control | Size
The Size command changes the size of theWinSight desktop window with your keyboard.
Use the arrow cursor keys to move the window borders. Press Enter when you are satisfied with the 
window size.
Size is available only if the WinSight desktop is not maximized.



Control | Minimize
The Minimize command turns the WinSight desktop into the WinSight icon.
You can choose this command only if the WinSight desktop window is not minimized.



Control | Maximize
The Maximize command zooms the WinSight desktop to fill your entire screen.
You can choose this command only if the WinSight desktop window is not maximized.



Control | Close
The Close command closes the WinSight desktop and unloads WinSight from memory.
You can also click the Control-menu box in the upper left corner to close the window.



Control | Switch To
The Switch To command displays the Task List dialog box where you can switch from one application 
to another and rearrange application windows.



Task List Dialog Box
Use the Task List dialog box to switch to another application and rearrange application windows.

Task List list box
The Task List list box displays all open applications. To choose the application you want, double-click 
it.
From the keyboard, follow these steps:
1 Press the Up or Down arrow keys to reach the application you want. 
2 Press Enter to choose it.
3 Switch to the application and rearrange windows with Action Buttons.

Action Buttons
Use the Action buttons to switch to another application and rearrange application windows.

With the mouse, click the action button you want. 

With the keyboard, press Tab to go to the action button, then press Enter.

Switch To
The Switch To button switches to another application in the list box.

End Task
The End Task button closes the selected application in the list box.

Cascade
The Cascade button arranges the application windows in an overlap style.

Tile
The Tile button arranges the application windows in a tile fashion (side-by-side).

Arrange Icons
The Arrange Icons button evenly spaces the icons across the bottom of the desktop.






